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Welcome to TuneLab Pocket - a piano tuning program that runs on a Pocket PC (Windows
Mobile) PDA or cellphone with a touch-sensitive screen.  This document will guide you step-
by-step through the process of installation, calibration, tuning setup, and the actual tuning.
For a complete reference on all the features of TuneLab, see the manual.  Our focus here will
be on the most common and essential aspects of TuneLab.

Installation
There are several ways to install TuneLab on your Pocket PC including infrared beaming,
special programs for a Macintosh computer, and removeable memory cards.  But the most
common way to install TuneLab is through a USB connection to a Windows desktop
computer.

ActiveSync

Pocket PCs are normally supplied with a USB cable and a CD containing a program
called ActiveSync.  If you do not have a CD with ActiveSync, you can download the latest
ActiveSync software for free from the Microsoft Windows Mobile website:

http://microsoft.com/windowsmobile

Note: Windows Vista does not use ActiveSync.  Instead you can download something
called the Windows Mobile Device Center for Vista from this Microsoft webpage:

http://www.microsoft.com/windowsmobile/devicecenter.mspx

ActiveSync is the Microsoft program that makes it possible to connect your Pocket PC
with your Windows computer.  If you have just purchased a Pocket PC, read the
documents that came with your Pocket PC and follow the instructions for installing
ActiveSync on your Windows computer before you attempt to connect your Pocket PC to
your computer.  If you connect your Pocket PC to your Windows computer before
ActiveSync is installed on that computer, Windows will not be able to recognize your
Pocket PC as a USB device.

After you have installed ActiveSync on your computer, you can connect your Pocket PC to
your computer using the supplied USB cable.  When you do this, your Windows computer
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will automatically recognize the Pocket PC and ActiveSync will ask you if you would like to
establish a partnership between your Pocket PC and your Windows computer.
Establishing a partnership is a way of synchronizing certain applications, like Excel and
Word, so that they can share common documents.  If you are planning on using this
synchronization facility for these other applications, then you may establish the
partnership for that purpose.  But TuneLab does use this form of synchronization, so
establishing a formal partnership using ActiveSync is entirely optional.  For the purposes
of installing TuneLab, it is sufficient to check the “Guest” selection when ActiveSync asks
you about a partnership.  The only important thing is that you verify that the ActiveSync
window does appear and that it says “Connected”.

Downloading the Installation Program (TUNELAB_POCKET_SETUP.EXE)

TuneLab is supplied or downloaded in the form of an installation program.  This is a
program that is meant to be run on your Windows computer.  If you are downloading the
program from our website, then your Internet browser will ask you if you would like to run
or save the program.  While you could just download and run the installation all in one
step, we recommend the two-step approach.  When your browser asks you what it should
do with the downloaded installation program, choose “save”.  Then you will be asked
where you would like the browser to save the program file.  Make sure you know where it
is being saved so you can find it later.  After you have saved the installation program
(TUNELAB_POCKET_SETUP.EXE), you may disconnect from the Internet.  If the
computer where you did the download is not the same computer where you intend to
connect your Pocket PC, you could at this point copy the downloaded installation program
to some kind of removable media and carry it to a different computer to do the actually
installation.  You could also make a backup of this installation program so you can re-
install TuneLab later on.

Running the Installation Program

You do not need any connection to the Internet to run the installation program for
TuneLab.  You only need to have the installation program on your Windows computer.
First ensure that your Pocket PC is connected and that ActiveSync has recognized the
connection.  Then run TUNELAB_POCKET_SETUP.EXE on your Windows computer and
follow the on-screen instructions.  This program will use the USB connection to your
Pocket PC to transfer TuneLab Pocket.  At one point in the installation you will be asked
to look at your Pocket PC screen and do whatever is needed to complete the installation
there.  Your Pocket PC may display a message saying that TuneLab Pocket is from an
unknown publisher and it will ask you if it should proceed with the installation anyway.
This message is normal and it just means that this particular version of TuneLab has not
been digitally signed.  TuneLab is normally distributed as an unsigned program for
compatibility with older Pocket PCs that cannot deal with signed programs.  If you need
the signed version of TuneLab Pocket, contact us and we will provide it to you by e-mail.
Make sure to answer the “unknown publisher” question promptly because your Pocket PC
will eventually time-out and assume that you had answered “no”.  If this happens, then get
the signed version of TuneLab and it will install without any questions.
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 Running TuneLab Pocket
From the Start menu on your Pocket PC, select Programs, and then look for the
TuneLab icon as shown to the right.  Tap on this icon to start running TuneLab. If you
want to start TuneLab even more easily, you can assign it to one of the buttons on
your Pocket PC.  From the Start menu on your Pocket PC select Settings, Personal,
and Buttons; then make your assignment.  TuneLab Pocket will also run if you tap on any
tuning file in the File Explorer.

Free Trial vs. Paid Mode

TuneLab Pocket initially installs as the free-trial version.  You can use it in this mode
indefinitely.  The free-trial mode is fully functional with no restrictions, except that the
program will occasionally pause for two minutes with a message about buying the
program.  If you have purchased a license for TuneLab Pocket, then you can eliminate the
two-minute pauses by switching to the paid mode from the Help - Register menu in
TuneLab.  Here you can enter your license number that is keyed to your name, which you
have entered in the Pocket PC under Settings, Personal, Owner Information.

Calibration

TuneLab uses a quartz crystal in your Pocket PC as the pitch reference.  While these
crystals are very stable and normally quite accurate, they are not perfect.  We strongly
recommend that you calibrate TuneLab on your Pocket PC before relying on it for ultimate
accuracy.  The manual for TuneLab Pocket contains a chapter on calibration, which we
will not repeat here.  After you perform a proper calibration, any error in the quartz crystal
frequency will be perfectly compensated and TuneLab will be accurate to 1/100 of a cent.
Since calibration depends on using several features of TuneLab, such as locking mode
and opening tuning files, you might want to postpone doing a calibration until you are
more familiar with these features.  Just make sure you do return to calibration at some
time.  A calibration remains in effect forever unless you do a Cold Start on your Pocket
PC, in which case you would have to re-install TuneLab too.

Closing the Program

If TuneLab is running on your Pocket PC and you want to run some other program, you
can simply start up the new program and leave TuneLab running in the background.  If
you want to run a program that uses the microphone, or the sound system, or if you want
to install a new version of TuneLab, then you will have to close TuneLab completely.
Note: the “x” in the upper right corner of the screen does not close TuneLab.  It merely
takes TuneLab off the screen, leaving it running in background.  However, you can truly
close TuneLab by tapping on the Close menu item in the main TuneLab menu.

Accessing Help
When TuneLab Pocket is installed on your Pocket PC, it comes with a help file that is also
installed on the Pocket PC and which can be accessed from various points in the program.
There is always a “Help” menu item at the bottom of the screen.  Tap on the “Help” menu
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item to see help for the particular screen that is showing.  The help that is available from the
main screen covers all the major functions.  The on-line help is meant to be used in
conjunction with the general TuneLab Pocket manual.  For more information about TuneLab
in printed form, see the accompanying TuneLab Pocket Manual.  If you want the latest
version of the TuneLab Pocket Manual you can download the Manual as a PDF file from our
web site, www.tunelab-world.com.

TuneLab Tutorial
This tutorial is meant to introduce you to certain basic functions of TuneLab by guiding you
through some exercises.  It is not meant to provide in-depth understanding of the principles
involved.  For that you should consult the TuneLab Pocket Manual.  To use this tutorial, first
start running TuneLab according the directions given above.

Selecting Notes:

In the center of the screen there is a display of the currently selected note.  It is initially
A4.  Just below that is a graph called the spectrum display.  Tap in the lower right
quadrant of the spectrum display.  The quadrant should momentarily turn gray and then
you should see the next higher note (A#4) displayed in the current note box.

Tap anywhere in the lower left quadrant of the spectrum display.  You should see the next
lower note displayed in the current note box.  Experiment with changing notes by tapping
in the lower portion of the spectrum display to see that you can select any note.

Tap anywhere in the upper right or upper left quadrant of the spectrum display.  The
quadrant should momentarily turn gray and then you should see the octave number in the
current note box change up or down by one.  Experiment with tapping in various
quadrants of the spectrum display to see that you can quickly select any note by changing
to the desired octave and then to the desired note. As you change notes, notice how the
frequency and partial change in the current settings box, which is just above the current
note box.

Select A4 by tapping on the spectrum display.  Tap on “ManualNote” or whatever is in the
bottom middle of the current settings box.  In the menu that pops up, select “Auto Up”.
Notice that "AutoUP" now appears in the field that you tapped.  Play A#4 on a piano and
watch how the current note automatically switches to A#4.  Continue playing up the scale
and watch how TuneLab Pocket follows the notes that you play.  Tap on “AutoUP” and
return the selection to “manual only” to turn off automatic note switching.

Tap on the keyboard icon in the lower right of the screen to bring up the “soft keyboard”.
Use this keyboard to select notes and octaves by tapping on A-G and 0-8.  The soft
keyboard will automatically do down after you enter an octave number.
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Tuning with the Spectrum Display:

Select A4. From the View menu select Spectrum
Zoom 130 cents so that spectrum display looks
like the picture on the right when you play A4 on a
piano.  Notice that the red line in the center of the
spectrum display corresponds to the exact pitch for
the select note and that the green lines correspond to 10 cents and 100 cents from the
red line.  If the peak of the graph is to the left of the red line then the note on the piano is
flat.  If the peak is to the right of the red line then the note is sharp.  If you do not see a
peak in the graph, then your microphone may not be working, or you are not playing the
selected note.  If you play the next note up the scale, the peak should move to the right-
most green line.  Playing the selected note, tune the piano until the peak in the spectrum
graph is centered at the red line.  Normally you only use this display for rough tuning, but
this display can be very useful for tuning the high treble.  For more precision you can
select Spectrum Zoom 50 cents.

Tuning with the Phase Display:

Select A4. Play note A4 on the piano. Note the
moving squares in the box above the current note
box.  If the squares move to the right then the note on
the piano is sharp.  If the squares move to the left then the note is flat.  Tune the note A4
(with only one string sounding) until the black squares are standing still.

Measuring Inharmonicity:

Select the note C3.  Mute all but one string of the note C3
in the piano. Tap the  M button in the toolbar to enable an
inharmonicity measurement.  Note the box that appears
saying "Measuring, (trigger?)".  Play and hold C3 on the
piano.  The measurement status should change to
"(listening)" right away.  Hold the note until the status
changes or a results box appears (about 6 seconds).
After a short calculation, you should see a results box
appear.  There should be cents offsets for several partials
and an inharmonicity constant displayed.  Tap on "Save".
Repeat the procedure taking inharmonicity measurements
for C1, C2, C4, and C5.

Adjusting the Tuning Curve:

After measuring inharmonicity for 5 or 6 notes, tap on the  button in the toolbar to see
the tuning curve and make an adjustment.  There are three modes of adjustment: manual,
semi-automatic (also called Auto-A0-C8 in the Edit menu), and fully-automatic, as shown
below.
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          manual mode                      semi-automatic mode                fully-automatic mode

We recommend using the fully-automatic mode, which is the default.  If you want to use
one of the other modes, see the TuneLab Pocket manual for
instructions.  To ensure that the fully-automatic mode is
selected, use the Edit menu in the tuning curve screen, as
shown to the right.  In the fully-automatic mode, all you need
to do adjust the tuning curve to match the inharmonicity
measurements is to tap just once on any one of the “Auto”
buttons between the two graphs.  You do not have to concern yourself with the two
graphs.  If you curious about what these graphs mean, see the TuneLab Pocket manual.
The upper graph shows the actual tuning curve, which gives the calculated amount of
stretch for each note.  The tuning curve value at the right end shows the stretch at C8,
which is typically between 25 and 45 cents.

Even if you are using the fully-automatic mode, you still can have some control over how
the tuning curve adjustments turn out through the selection of the bass and treble
intervals.  These are the intervals shown in the two boxes between the two graphs.
These intervals are described in terms of the coincident partial number that define them.
Here are the expanded definitions:

                Bass Intervals                          Treble Intervals  
4:2 single octaves 3:2 fifths 2:1 single octaves
6:3 single octaves 6:4 fifths 4:2 single octaves
8:4 single octaves 3:1 12ths 4:1 double octaves
10:5 single octaves 6:2 12ths 8:2 double octaves
12:6 single octaves 6:1 octave+12ths 8:1 triple octaves
4:1 double octaves 3:2 fifths
8:2 double octaves 6:4 fifths
12:3 double octaves 3:1 12ths
8:1 triple octaves 6:1 octave+12ths
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The most common selections are 6:3 in the bass and 4:1 or 4:2 in the treble.  In general,
adjusting for pure 4:2 octaves in the treble gives a little more stretch than adjusting for
pure 4:1 octaves.  We recommend that you stick to these selections unless you have a
strong reason to do otherwise.  To make a change to either the bass or the treble interval
selection, just tap on the selection box and the entire list of intervals will be displayed.  If
necessary, scroll through the choices to select the interval that you want.

When you change an interval selection, this does not automatically adjust the tuning curve
to match that selection.  If you want to have the tuning curve adjustment based on a new
interval selection, then tap again on one of the “Auto” buttons and you will see a change
in the tuning curve (the upper graph).  For example, change between the 4:1 and the 4:2
intervals in the treble and see how the stretch at C8 changes.

Adjusting the Offset:

Tap somewhere near the right end of the phase display.  If a message box appears, just
select YES.  Notice that an offset display appears in the current settings box and that it
goes up every time to tap on the phase display. Tap somewhere closer to the center of
the phase display.  Notice that the offset goes up by smaller amounts when you tap closer
to the center of the phase display.

Tap somewhere near the left end of the phase display.  Notice that the offset goes down
every time you tap, and that the amount by which it goes down depends of whether you
tap near the left end or closer to the center.  From the Edit menu, select Enter Current
Settings.  Notice that there is an box in which you can enter an exact offset using the
keyboard that has just popped up at the bottom of the screen.  Enter 0.25 cents in the
Offset field.  Then tap on the Done menu at the bottom or the OK button on the top.
Notice how the offset is now 0.25 in the current settings box.  This is an alternate way to
enter an offset.  Tap on the current offset display itself.  Select “Zero This Offset” in the
menu that appears.  The offset has now been set back to zero.

The offset affects all the notes of the scale uniformly.  By entering an offset you can
change the pitch standard from A-440 to something else.

Pitch-Raise (Over-Pull) Tuning:

Select note A0. Tap the  button in the toolbar to bring up the over-pull settings box.  In
this box tap the Begin button to enable over-pull tuning mode. Play A0 on the piano.
Note how the over-pull status changes from "(trigger?)" to "(measuring)" to "was at...".
The number of cents shown in the status box is the measured condition of the string
before you start to tune it.  Notice how the pre-tuning measurement is placed in the history
list on the left side of the screen. Note: If playing the note does not trigger a
measurement, play the note again.  If a bad measurement is taken, tap the M button in
the toolbar to re-measure that note. Tap  M several times to remove several bad entries in
the history list.

Tune A0 for an in-tune indication in the spectrum display and the phase display. Select
the next higher note by tapping in the lower right quadrant of the spectrum display.  Notice
how the over-pull status box changes back to "(trigger?)".  Play A#0 on the piano.  After
the measurement has been taken, tune A#0 as usual. Continue selecting notes in order,
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playing them for a pre-tuning measurement, and tuning them normally.  Tune unisons as
you go. Tap the right side or left side of the phase display.  Note how doing this changes
the over-pull percentage by 1% up or down.  To cancel over-pull tuning mode, tap the 
button and then tap on “Stop using over-pull”.

Write your Pocket PC Owner Name and TuneLab Pocket License Number
here.  This data together with a backup of the installation program is all
you need to re-install TuneLab again later.

Owner Name:

License Number:


